
 Geoff Hamiltons 3D Garden Designer Help Index

General Description

Structure of a Garden Document:
Plan Window
3D Window
Landscape Window
Encyclopedia Window
Care Window
Notes Window

How To ...
Manage plant species:

Changing the current plant species
View care calendar for the current plant species
View possible diseases for the current plant species
View and edit note text for the current plant species
Creating and using a new set of plants
Print Encyclopedia Window
Print Care Window

Manage plan objects:
Placing an object in the garden plan
Selecting an object or group of objects
Copy an object or group of objects
Changing size of an object or group of objects
Changing placement of an object or group of objects
Changing orientation of an object or group of objects
Changing the curvature of an object
Flipping an object or group of objects
Replacing a plant
Viewing and changing properties of an object
Viewing and editing note text for an object

Commands:
File menu
Edit menu
Place menu
Plant menu
View menu
Window menu
Help menu





File Menu Commands.

The File menu offers the following commands:

Command Action
New Create a new document.
Open Open an existing document.
Close Closes an opened document.
Save Save an opened document using the same file name.
Save As Save an opened document to a specified file name.
Print Prints a document.
Print Setup Select a printer and printer connection.
Load on 
Startup

Toggles the loading of the most recently opened file on 
start-up.

Exit Exits application.



Load on Startup Command (File menu)

This command allows you to choose whether to open the last garden you were working on 
at startup.
If the menu item is checked, then program will load the last used document next time the 
program is started up.



Edit Menu Commands

The Edit menu offers the following commands:

Comman
d

Action

Undo Reverse previous editing operation.
Redo Redo last undone operation
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Paste Link Pastes from the clipboard a link to data in another application.
Delete Deletes selected objects
Select All Selects all the items within a document
Deselect Deselects object or group of object
Insert New
Object

Inserts and embeds an object, such as a chart or an equation in a document.

Links List and edit links to embedded documents.
Object Activate an embedded object for editing.

Deselect Command (Edit menu)

Use this command to deselect an object or group of objects in the Plan Window



Delete Command (Edit menu)

Use this command to delete currently selected objects.

Shortcuts
Keys: Del



Select All Command (Edit menu)

Use this command to select all the objects within a garden plan.



View Menu Commands

The View menu offers the following commands:

Command Action
Main Toolbar Shows or hides the Main Toolbar.
Plan Toolbar Shows or hides the Plan Toolbar.
Rulers Shows or hides the plan rulers
Status Bar Shows or hides the status bar
Plan Options Set garden plan view options
Background Set garden plan background 
Month Select the month in which you would like to view 

your garden
Camera list Show the cameras list.
Set Sky Show Select Sky dialog box.
Landscape 
Toolbar

Shows or hides the Landscape Toolbar.

3D Toolbar Shows or hides the 3D Toolbar.
Setup Contour
Lines

Shows or hides the Contour Lines.



Window Menu Commands

The Window menu offers the following commands, which enables you to arrange multiple 
views of multiple documents in the application window:

Command Action
Duplicate Create a new window that views the same document.
Cascade Arrange windows in an overlapped fashion.
Tile 
Horizontal

Horizontally arrange windows on screen without 
overlapping.

Tile Vertical Vertically arrange windows on screen without 
overlapping.

Arrange 
Icons

Arrange icons of minimized windows.

Synchronize 
by plant

Synchronize all document views to show the same plant 
species.

Plan Activate plan window of current document.
Landscape Activate landscape window of current document.
3D View Activate 3D view window of current document.
Encyclopedia Activate encyclopedia window of current document.
Care Activate care window of current document.
Notes Activate notes window of current document.
Window 1, 2,
...

Goes to the specified window.



Synchronize by Plant Command (Window menu)

Use this command to set synchronization mode of document windows. Having this turned 
ON synchronizes all document views to show the same plant species; turned OFF, each 
window behaves independently of the others.

Shortcuts
Keys: CTRL+F9



Plan Command (Window menu)

Use this command to activate the Plan Window of the current document
See Plan Window for more information about editing a garden plan. 

Shortcuts
Main Toolbar:

Keys: Alt+1



Landscape Command (Window menu)

Use this command to activate the Landscape Window of the current document
See Landscape Window for more information. 

Shortcuts
Main Toolbar:

Keys: Alt+5



3D View Command (Window menu)

Use this command to activate the 3D View Window of the current document
See 3D Window for more information. 

Shortcuts
Main Toolbar:

Keys: Alt+6



Care Command (Window menu)

Use this command to activate the Care Window of the current document
See Care Window for more information about the garden care window

Shortcuts
Main Toolbar:

Keys: Alt+3



Notes Command (Window menu)

Use this command to activate the Notes Window for the current document
See Notes Window for more information about the notes window

Shortcuts
Main Toolbar:

Keys: Alt+4



Encyclopedia Command (Window menu)

Use this command to show the Encyclopedia Window.
See Encyclopedia Window for more information about the plant encyclopedia.

Shortcuts
Main Toolbar:

Keys: Alt+2



Help Menu Commands

The Help menu offers the following commands, which provide assistance with this 
application: 

Command Action
Index Offers you an index of topics on which you can get help.
Using Help Provides general instructions on using help.
Context Help Provides help on a specific application.
GSP on the 
Web    

Takes you to GSPs Home page.

About Displays the version number of this application.



New Command (File menu)

Use this command to create a new document.
You can open an existing document with the Open command.

Shortcuts
Main Toolbar:

Keys: CTRL+N



Open Command (File menu)

Use this command to open an existing document in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.
See Window 1, 2, ... command.
You can create new documents with the New command.

Shortcuts
Main Toolbar:

Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.

List Files of Type
Select the type of file you want to open: i.e. *.GRD

Drives
Select the drive you want, which will then display a file and directory list.

Directories
Select the directory required which will then display the relevant file list.

Network...
This button is available if you are running Windows for Workgroups 3.11 or Windows 95 
and above. Choose this button to connect to a network location, assigning it a new drive 
letter. 



Close Command (File menu)

Use this command to close all windows containing the active document.    The program will 
suggest that you save the changes to your document before you close it.    If you close a 
document without saving, you will lose all changes made since the last time you saved it.    
Before closing an Untitled document the Save As dialog box will be displayed. This will 
suggest that you name and save the document.

You can also close a document by using the Close icon on the document's window, as 
shown below:



Save Command (File menu)

Use this command to save the active document with its current name and directory.    When
you save a document for the first time, it will display the Save As dialog box so you can 
name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts
Main Toolbar:

Keys: CTRL+S



Save As Command (File menu)

Use this command to save and name the active document.    The program displays the Save
As dialog box so you can name your document.

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you are about to
save:

File Name
Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    The application adds 
the extension specified in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

List Files of Type
Select the type of file you want to save.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 Command (File menu)

At the bottom of the File menu, the 4 most recently opened files are listed. Selecting one of
these options will enable you to open that document quickly.



Exit Command (File menu)

Use this command to end your Garden Design session.    You can also use the Close 
command on the application Control menu.    The program will prompt you to save your 
changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo / Can't Undo Command (Edit menu)

Use this command to reverse the last editing action, if possible.

Shortcuts
Main Toolbar:

Keys: CTRL+Z or ALT+BACKSPACE



Redo Command (Edit menu)

Use this command to redo the last undone operation, if possible.

Shortcuts
Main Toolbar:

Keys: CTRL+A 



Cut Command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

NOTE: Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts
Main Toolbar:

Keys: CTRL+X



Copy Command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable 
if there is no data currently selected.

NOTE: Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Main Toolbar:

Keys: CTRL+C



Paste Command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts
Main Toolbar:

Keys: CTRL+V



Main Toolbar Command (View menu)

Use this command to display and hide the Main Toolbar, which includes buttons for some of
the most common commands in the application, such as File Open.    A check mark appears
next to the menu item when the Main Toolbar is displayed.

See Main Toolbar for help on using the Main Toolbar.



Plan Toolbar Command (View menu)

Use this command to display and hide the Plan Toolbar of currently active plan window. This
toolbar includes buttons for some of the commands in the garden plan, such as Structure, 
Decor etc.    A check mark appears next to the menu item when the Plan Toolbar is 
displayed.

See Plan Toolbar for help on using the Plan Toolbar.



Rulers Command (View menu)

Use this command to display and hide the Rulers of the currently active Plan Window. A 
check mark appears next to the menu item when the Rulers are displayed.

See Rulers for help on using the rulers.



Background Command (View menu)

Use this command to choose the background of the garden plan.

The command displays the Plan Background dialog box.



Month Command (View menu)

Use this command to select the month in which you would like to view your garden.

The command shows the Month dialog box.



3D Toolbar Command (View menu)

Use this command to display or hide the 3D Toolbar, which includes buttons for some of the
commands to control the 3D View Window.    A check mark appears next to the menu item 
when the 3D Toolbar is displayed.

See 3D Toolbar for help on using the 3D Toolbar.



Landscape Toolbar Command (View menu)

Use this command to display or hide the Landscape Toolbar, which includes buttons for 
some of the most common commands for controlling the Landscape View Window.    A 
check mark appears next to the menu item when the Landscape Toolbar is displayed.

See Landscape Toolbar for help on using the Landscape Toolbar.



Setup Contour Lines Command (View menu)

Use this command to display Contour Lines Properties Dialog Box.

Shortcuts
Landscape Toolbar:



Camera list Command (View menu)

Use this command to show the camera list to enable you to choose the one that you want 
to view from.



Set Sky Command (View menu)

Use this command to choose the Sky you want to be displayed.



Main Toolbar

The Main Toolbar is displayed across the top of the application window, below the menu 
bar.    The Main Toolbar provides quick mouse access to many tools used in application.

To hide or display the Main Toolbar, choose Main Toolbar item from the View menu (ALT, V, 
T).

Click To

Open an existing document.    Program 
displays the Open dialog box, in which 
you can locate and open the desired 
file.
Save the active document with its 
current name.    If you have not named 
the document, the application displays 
the Save As dialog box.

Removes selected data from the 
document and store it on the clipboard.
Copy the current selection to the 
clipboard.
Insert the contents of the clipboard at 
the insertion point.

Reverse the last action.    
NOTE:    You cannot undo some actions.
Redo the previous undo action.

Activate Plan Window for the current 
document.
Activate Landscape Window for the 
current document.
Activate 3D View Window for the 
current document.
Activate Care Window for the current 
document.
Activate the Encyclopedia Window.
Activate Notes Window for the current 
document.



Show Care Calendar for current plant 
species.
View and edit note text for the current 
plant species.
View a list of possible plant diseases for
current plant species.

Print the active document.

Display context sensitive help for a 
selected object.



Plan Toolbar

The Plan Toolbar is displayed across the top of the plan window, below the title bar.    The 
Plan Toolbar provides quick mouse access to many tools used in the plan window.

To hide or display the Plan Toolbar, choose Plan Toolbar item from the View menu (ALT, V, 
P).

Click To

Place surface object in plan.
Place structure object in plan.
Place a fencing object in plan.

Place a decor object in plan.
Place a lighting object in plan.
Place a vehicle object in plan.
Place a camera object in plan.

Place a plant object in plan.

View and change garden plan options.
Zoom out of garden display.
Zoom into garden display.

View garden plan during day time.
View garden plan during night time.



Status Bar Command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, along with the current 
cursor location. A check mark appears next to the menu item when the Status Bar is 
displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the program window.    To display or hide the 
status bar, use the Status Bar command in the View menu.
The left area of the status bar describes actions of menu items as you use the arrow keys to
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the 
description of the toolbar button command you do not wish to execute the command, then 
release the mouse button while the pointer is off the toolbar button.
The far right of the status bar shows the X and Y co-ordinate of cursor, angle, or dimensions
of an object depending on the current operation. 



Rulers

The rulers are displayed around the top and left sides of the Plan Window.    To display or 
hide the rulers, use the Rulers command in the View menu.
Use the left mouse button to click and drag on a ruler to add guidelines for aligning objects 
and the like. Drag guidelines back to a ruler to delete them.

Click and drag on the top left corner of the ruler to change the origin of coordinates.



Duplicate Command (Window menu)

Use this command to open a new window with the same contents as the active window.    
You can open multiple document windows to display different parts or views of a document 
at the same time.    If you change the contents in one window, all other windows containing 
the same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade Command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.



Tile Horizontal Command (Window menu)

Use this command to horizontally arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical Command (Window menu)

Use this command to arrange multiple opened windows side by side.



Arrange Icons Command (Window menu)

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... Command (Window menu)

The Application displays a list of currently open document windows at the bottom of the 
Window menu.    A check mark appears in front of the document name of the active 
window.    Choose a document from this list to make its window active.



Index Command (Help menu)

Use this command to display the Help contents screen.    From the opening screen, you can 
jump to step-by-step instructions for using the application and various types of reference 
information.
Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help Command (Help menu)

Use this command for instructions about using Help.



About Command (Help menu)

Use this command to display the copyright notice and version number of your program 
copy.



Context Help Command (Help menu)

Use the Context Help command to obtain help on a particular part of the program.    When 
you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow 
and a question mark.    Click somewhere in the application window, such as another Toolbar 
button, and a Help topic will be shown for the item you clicked on.

Shortcut
Main Toolbar:
Keys: SHIFT+F1



GSP on the Web Command (Help menu)

Use this command to show GSPS home page.



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and the document that you are working on.
To move the window, drag the title bar.    

NOTE: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

These are displayed at the right and bottom edges of the document window.    The scroll 
boxes inside the scroll bars indicate your vertical and horizontal location in the document.    
You can use the mouse to scroll to other parts of the document.



Size Command (System menu)

Use this command to display a four-headed arrow so you can size the active window with 
the arrow keys.

To change size of the active window with arrow keys:

1.      Choose this command from the active window System menu. After the pointer 
changes to the four-headed arrow: 

2.      Press one of the direction keys (left, right, up, or down arrow key) to move the pointer 
to the border you want to move.    
3.      Press a direction key to move the border.
4.      Press ENTER when the window is the size you want.

NOTE: This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move Command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

To move the active window with the arrow keys:

1.      Choose this command from the active window System menu. After the pointer 
changes to the four-headed arrow: 

2.      Press one of the direction keys (left, right, up, or down arrow keys) to move the pointer 
with the window to the place where you want to move the window to.
3.      Press ENTER when the window is in the desired location.

NOTE:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the window title bar.



Minimize Command (application Control menu)

Use this command to reduce the program window to an icon.

Shortcut
Mouse: Click the minimize icon  on the title bar.



i$Maximize Command (System menu)

Use this command to enlarge the active window to fill all the available space.

Shortcut
Mouse: Click the maximize icon  on the title bar; or double-click the title bar.



Next Window Command (document Control menu)

Use this command to switch to the next open document window.    The program determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Close Command (Control menu)

Use this command to close the active window or dialog box.
Double-clicking a Control menu box is the same as choosing the Close command.

NOTE:: If you have multiple windows open for a single document, the Close command on 
the document Control menu closes only one window at a time.    You can close all windows 
at once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the application window or dialog box



Restore Command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to Command (application Control menu)

Use this command to display a list of all open applications.    Use this Task List to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with 
the following options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.





Fit to size Command (Control menu)

This command will change the size of the window so that all the controls of it are visible.

NOTE: If size of document window fits the controls layout, the command is unavailable.



Paste Link Command (Edit menu)

Use this command to paste and link an object from another OLE server application. 
Changes made to an object in the source document will be reflected in your document.



Links Command (Edit menu)

Use this command to display a    Links dialog box that lets you edit links between your 
document and other documents.

NOTE: This command is unavailable if you have no links in your document.



Convert object (Edit menu)

Specify a different source application for an embedded object.

See also: Convert dialog box



Links dialog box

This dialog lists the source documents for the active document and provides options you 
can use to change the links in linked documents.

Source File
Lists the names of source documents.

Item
Lists the sources of the links.

Type
Describes the linked item.

Status
Indicate whether the link is updated manually or automatically.

Open
Open the selected source document.

Close
The Close button appears in the Links dialog box when you firsts open it. 
Choosing the Close button cancels the command and closes the Links dialog box.

Change Source
Displays the Change Links dialog box, which you can use to redirect links to the 
dependent worksheet.

Update Now
Update the active dependent document with information from the selected source 
documents.

Automatic
Update the linked data automatically.

Manual
Update the linked data manually when you choose the Update Now button.





Object name (Edit menu)

This command activates an embedded object for editing. The name of this command will 
change corresponding with the type of the selected object.

Shortcut
Mouse: Double-click the object with the left mouse button.



Insert New Object Command (Edit menu)

Inserts and embeds an object, such as a chart or an equation in a document. The 
application in which the object was created becomes active on the screen.

Select the object you want to insert into your document by using the Insert New Object 
dialog box.



Insert New Object dialog box

This dialog inserts a new object into a document and has the following options.

Create New
Select this button to create and embed a new OLE object.

Create from File
Select this button to embed or link an object you have already created and saved using 
another OLE application.    After you select Create from File, the File box,    Browse button,
and the Link box appear.

Object Type
Lists the other OLE server applications installed on your computer.    Select an object type
from the list if you want to create and embed an object.    To embed or link an object you 
have already created and saved, choose Create from File.

Display As Icon
Select this box if you want to display the object as an icon.

File
Type the name and path of the file you want to link or embed.

Browse
Opens the Browse dialog box, in which you can choose the file you want to link or 
embed.

Link
Link the file displayed in the File box. (If you do not choose Link, the file will be 
embedded.)

Change Icon
Opens the Change Icon dialog box so you can select a different icon. 

Change Icon Dialog Box Options

Icon
Select the icon you want to represent an embedded or linked object.

Current
Display the current icon.

Default
Display the default icon.

From File
Type the name and path of the file containing the icon you want to use, or choose 
Browse to locate the file.



Label
Enter a label for the icon.

Browse
Locate the file with the icon you want to use to represent an embedded or linked object.



Convert dialog box

In this dialog you can convert an embedded object to another application format. For 
example if a document has an embedded Microsoft Excel object and you don't have Excel 
you can convert it to a format your    spreadsheet application can use.

Covert To
Select this radio button to convert the embedded object to the type of file that you 
specify in the Object Type box.

Activate As
Select this radio button to open embedded objects in the file format you specify in the 
Object Type box.

Display As Icon
Select this box if you want to display the object as an icon.

Change Icon
Opens the Change Icon dialog box so you can select a different icon. 

Change Icon Dialog Box Options

Icon
Select the icon you want to represent an embedded or linked object.

Current
Display the current icon.

Default
Display the default icon.

From File
Type the name and path of the file containing the icon you want to use, or choose 
Browse to locate the file.

Label
Enter a label for the icon.

Browse
Locate the file with the icon you want to use to represent an embedded or linked object.





Update Command (File menu)

No help available



Save Copy As... Command (File menu)

No help available 



Embedded Object Resize Bar

No help available 



Print Command (File menu)

Use this command to print a document. This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts
Main Toolbar:

Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
    
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Printing copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that the program is sending output to the 
printer. The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview Command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in
which one or two pages will be displayed in their printed format.    The Print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The Print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup Command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the currently installed printers shown in the box.    The 
installation and configuration of printer ports is done within the Windows Control Panel. 
Please consult your Windows manual for further information on how to do this.

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Landscape Toolbar

The Landscape Toolbar is displayed across the top of the landscape window, below the title 
bar.    The Landscape Toolbar provides quick mouse access to many tools used in the 
landscape window.

To hide or display the Landscape Toolbar, choose Landscape Toolbar item from the View 
menu (ALT, V, P).

Click To

Select an area in the landscape.
Place or delete a point object in the 
landscape.
Invoke Area Properties dialog.
Invoke Point Properties dialog.
Show Area Properties Dialog Box.
Show Contour Lines Properties Dialog 
Box.



Select Area Command (Landscape Toolbar)

Use this command to select Area object in plan.

Shortcuts
Landscape Toolbar:



Place or delete Point Command (Landscape Toolbar)

Use this command to place or delete a Point object in the landscape.

Shortcuts
Landscape Toolbar:



Area Properties Command (Landscape Toolbar)

Use this command to invoke Area Properties dialog.

Shortcuts
Landscape Toolbar:



Point Properties Command (Landscape Toolbar)

Use this command to invoke Point Properties dialog.

Shortcuts
Landscape Toolbar:



Sloping Command (Landscape Toolbar)

Use this command to invoke Point Properties dialog.

Shortcuts
Landscape Toolbar:



Setup Contour Lines (View menu)

Use this command to set the contour lines properties.
This command displays the Contour Lines Properties Dialog.

Shortcuts
Landscape Toolbar:



3D Toolbar

The 3D Toolbar is displayed across the top of the 3D window, below the title bar.    The 3D 
Toolbar provides quick mouse access to options used in the 3D window.

To hide or display the 3D Toolbar, choose 3D Toolbar item from the View menu (ALT, V, P).

Click To

Edit parameters of the current camera.
Change sky above the garden.





 General description of Garden Designer

Garden Designer (hereinafter - program or application) is a computer plant encyclopedia 
and garden planner.
Using the encyclopedia you may select plants using various criteria like a colour, flowering 
time, fragrance, etc.. and then place them in your garden plan. The flowering and foliage 
calendar also allow you to choose plants according to when they flower and bear leaves, 
and by the colour of their flowers or leaves.
The encyclopedia contains information on over 1500 plants. Information is based on 25 
parameters (such as form, size, colour) and each plant is illustrated with at least one colour
picture.
For each plant you can define possible diseases that it might suffer from.
For each plant there is a full care calendar, indicating what gardening tasks it requires and 
when. Some of these are illustrated with animation sequences.
You can build up the design of your garden using simple elements, (e.g. fences, paths, 
ponds), and then print it out as a record.
With the help of this program you can also see what the change in flower and leaf colours 
will be for different months of year.
The program can also allow for garden lighting and illustrate how your garden will look at 
night.
Some of key components and features of the program are detailed below:

Garden planner (Plan Window) is a graphic editor, specially developed to produce plans 
for gardens and parks. The editor uses realistic images of garden objects to produce a 
birds-eye plan of your garden. The main editing features include:

Placing/deleting objects;
Automatic overlapping and merging of objects;
The scaling and rotation of objects;
The saving / loading of garden plans;
Scrolling of garden plans;
The smooth Zoom feature;
Viewing the garden in different months;
Viewing the garden at night or during the daytime;
Guiding grid placed over the plan;
Selective display of objects on plans;
Compatibility with OLE 2 standards.

Encyclopedia of plants (Encyclopedia Window) containing information about all the 
plants in the application. It contains the following data:

The name - Common and Latin classification;
The appearance - (Image of size 200 * 200 pixels 256 colours);
View from above for the garden plan of scale 1:100;
Silhouette - a monochrome depiction 100 * 137 pixels;
The type of plants - deciduous and coniferous trees, bushes and hedges, herbs, grasses, ferns, climbers;
Light, moisture and temperature requirements
Height, width and life expectancy information;
What the plant can be used for;
The periods of flowering and leaf bearing;
The colour of fruits, flowers, leaves and autumn leaves;



The plant filter (Filter Window) helping to select plants based upon your selected criteria. 
Selection can be performed on all the information fields held by the encyclopedia.

Garden maintenance information (Care Window) listing all tasks required for the plants 
in your garden.

Plant care information (Care Calendar Dialog) an annual calendar for garden work 
required by each plant. Garden tasks are illustrated by small icons. Additional textual and 
graphic information is available to illustrate how to carry out this operation.

Plant diseases (Plant Diseases Dialog) lists diseases that may affect individual plants.

Notebook (Encyclopedia / Plan Notebook Dialog and Notes Window) allowing you to write 
comments on the garden, plants within the encyclopedia, or any individual object or plant 
in your garden plan.



Changing the current plant species

The current plant species is the one that was last selected in one of the document windows.
All the plant operations, obtained through the Plant menu or plant buttons , 

, 
 of the Main Toolbar, are with respect to this current species.

To change the current plant species you can select a plant object in the Plan Window or 
select a plant name in the Encyclopedia Window or Care Window.
Each window can retain its own current plant selection when switched between.
Alternatively, you can synchronize different windows to all show information on the last 
plant that you selected anywhere in the program through the Synchronize by plant setting. 
For example, bringing up a plan and an encyclopedia window allows you to select various 
plants in your garden plan, and have the encyclopedia show the corresponding information.
To turn this Synchronize mode off, select the Synchronize by plant setting.

See Also: Selection of an object or group of objects



Viewing the care calendar for the current plant species

To view the care calendar of the current plant species:

1.      Open Plant Care Dialog by using the Care Calendar command from the Plant menu.
2.      View the Care Calendar for the current plant species.
3.      Click on the Close button.



Viewing diseases for the current plant species

To view diseases for the current plant species:

1.      Open Plant Diseases Dialog by using the Plant Diseases command from the Plant 
menu.

2.      View the potential diseases for the current plant species.
3.      Click on the Close button.



Viewing and editing note text for the current plant species 

To view and edit note text for the current plant species:

1.      Open Encyclopedia Notebook Dialog by using the Notebook command from the Plant 
menu.

2.      View and edit the plant species note text.
3.      Click on the Close button.



Placing an object in the garden plan

To place a new object in your garden plan:

1.      To place Plant object          click          on the button  on the Plan Toolbar or by 
choosing Place item in Plant menu.

To place Surface object        click on the button  on the Plan Toolbar or choose 
Surface item in the Place menu.

To place Structure object    click on the button  on the Plan Toolbar or choose 
Structure item in the Place menu.
To place Fencing object      click on the button  on the Plan Toolbar or choose Fencing 
item in the Place menu.

To place Decor object      click      on    the button  on the Plan Toolbar or choose 
Decor item in the Place menu.

To place Lighting object    click    on the button  on the Plan Toolbar or choose Lighting
item in the Place menu.
To place Vehicle object      click on the button  on the Plan Toolbar or choose Vehicle 
item in the Place menu.

To place Camera object      click on the button  on the Plan Toolbar or choose 
Camera item in the Place menu.

2.      Choose the object properties from the object dialog.
3.      Click on the OK button.



Changing placement of an object or group of objects.

To move an object:
With the left mouse button pressed, drag the object to the position you require.

To move group of objects:
1.      Select objects which you need to move.
2.      With left mouse button pressed, drag any of the objects in the group to the position 

that you require.

Cursor will first appear as  and then take the form of 



Changing size of an object or group of objects.

To change the size of an object or group of objects:
1.      Enter at change size of an object mode by selection of an object or group of objects.

NOTE: It is not possible to change the size of some objects. For the objects in question 
change size of an object mode does not exists! In this case after selection you 
immediately enter at rotating object mode.

2.      Change the external size of an object or group of objects by dragging    the handle for 

changing external size. The Cursor will appear as 
Change the internal size of an object or group of objects by dragging the handle for 

changing internal size. The Cursor will appear as 

NOTE: It is not possible to change external or internal sizes of some objects or group of 
objects. Corresponding handles for changing the size will not appear on these objects or 
groups.
NOTE: In the process of changing the size of a group, objects that cant change size, will 
change their position in comparison to the others, but will conserve their size.
NOTE: There are limits that can be reached when changing the sizes of objects. Changing 
the size of an object does not occur if the object has reached these limits. When reducing 
the size of a group of objects, if the cursor crosses through the opposite edge of the 
selected group of objects, then they will flip.

See also: Cursor shapes, Flip group of objects.



Changing orientation of an object or group of objects.

To rotate an object or group of objects:
1.      Enter at changing size of an object mode by selection of an object or group of objects.

NOTE: It is impossible to change the size of some objects. For these objects change size of 
an object mode does not exist! In this case after selection, you will immediately enter at
rotating object mode. Therefore you will miss item 2.

2.      Enter rotating object mode by clicking the left hand mouse button on an object or on 
any object in a group once.

NOTE: It is impossible to rotate some objects. For these objects rotating an object mode 
does not exist! In this case after performing item 2 you will enter change size of an 
object mode.

3.      To change the centre of rotation of an object or group of objects drag the handle for 

changing the centre of rotation. The cursor will appear like 

4.      Rotate an object by dragging the handle for rotating . The cursor will appear as 

NOTE: In the process of rotating a group, objects, which cant rotate, will change their 
position compared to the others, but will conserve their orientation.

See also: Cursor shapes



Changing the curvature of an object.

To change the curvature of an object:
1.      Enter at change curvature of an object mode by selection of an object.

NOTE: It is not possible to change the curvature of some objects. For these objects change 
curvature of an object mode does not exist! In this case after selection you will 
immediately enter change size of an object mode if this mode exists or at rotating 
object mode.

NOTE: If an object can change size and curvature, change curvature of an object mode 
coincides with change size of an object mode.

2.      Change the curvature of an object by dragging the corresponding handle for changing 
curvature. The cursor will appear as 

See Also: Cursor shapes



Replacing a plant.

To replace a plant:
Use the right mouse button to select the plant, and then select Plant Object|Replace on 
the plant context menu.

See also: Selection of an object or group of objects



Selection of an object or group of objects

To select a single garden object: 
Click on it with the left mouse button.

To select group of objects on the garden plan:
Hold down the Shift key whilst clicking on all desired objects.
Or..
Place the mouse cursor on an empty part of the garden, and drag out a lasso whilst 
holding down the left mouse button. On releasing the left mouse button, all objects 
within the lasso area will be selected.

Selected objects are shaded in red.

NOTE: Any objects previously selected will be deselected when a new selection is made.

To remove a selection in the garden plan use the Deselect command.

See also: Changing the current plant species



Coping an object or group of objects.

To make a copy of an object or group of objects:
1.      Select an object or group of objects. See Selection of an object or group of objects.
2. Whilst holding down the Ctrl key, click and drag a copy of the selected object away from 

it. 
or

Select the Copy command from the edit menu to copy the selected objects onto the 
Clipboard. Then choose the Paste command to paste objects from the clipboard into the
garden plan. New objects will be pasted on top of the source objects and are selected. 

NOTE: To undo the Copy operation, use the  button on the Main Toolbar.

See also: Change placement of an object or group of objects and Change orientation of an 
object or group of objects.



Viewing and changing properties of an object

To change and view properties of an object:
Use the right mouse button to click on an object, and then select Properties from the 
objects menu.
Alternatively, double click on the object with the left mouse button.



Printing Encyclopedia Window

To print Encyclopedia Window:

1.      Open the Encyclopedia Window by clicking on the button  from the Main Toolbar or 
select Encyclopedia from the Window menu.

2.      Choose the plant which you want to print, from the List of plants.

3.      Use the left mouse button to select the  button from the Main Toolbar, or select 
Print command from the File menu the Print dialog box. will then appear.

4.      Click the Setup button from the Print dialog box which will in turn bring up the Print 
Setup dialog box and then setup printer. Set the printer up as required then click on the 
OK button to close the Print Setup dialog box and accept the changes made.

5.      Click on the OK button to print the Encyclopedia Window.



Printing Care Window

To print the Care Window:

1.      Open the Care Window by selecting the  button from the Main Toolbar or choose 
Care item from the Window menu.

2.      Choose the month which you want to print from by clicking on any icon in the column 
of the chosen month.

NOTE: All Month columns that fit on the page will be printed, not just the individual month.

3.      Choose the Print Setup command from the File menu which will bring up the Print 
Setup dialog box . Then setup the printer as required.

NOTE: It is recommend to print with Landscape Orientation selected from the Print Setup 
dialog box.

4.      Choose the Print Preview command from the File menu to display the Care Window as 
it will appear when printed.

5.      Use the left mouse button to select the  button from the Main Toolbar or select the 
Print command from the File menu to bring up the Print dialog box.

6.      Click on the OK button to print the Care Window.



Flipping an object or group of objects

To flip an object or group of objects:
1.      Select the object or group of objects which you want to flip. See Selection of an object 

or group of objects. Upon selection you enter change size of an object mode.
2.      Flip selected object or group of objects by dragging the corresponding handle for 

changing external size in the direction that you wish to flip it. When this handle crosses 
the line, it will connect with the two other handles, then the object or group of objects 
will flip.

See also: Change size of an object or group of objects and Change orientation of an object 
or group of objects.



Viewing and editing object notes

You can view and edit object note text for any object in the Plan Notebook Dialog.

To view and edit object note text:
Use the right mouse button to click on an object, and then select the Comments 
command from the object type submenu.



Creation and using new set of plants

You can create a new set of plants and then use it within your own garden as a new criteria 
in the Plant Filter.

To create a new set of plants:
1.      Create your garden and place the plants you want in it, that you need to use in other 

gardens as a new criteria in the Plant Filter.

2.      Enter notes for garden by clicking on the  button from the Main Toolbar or select 
the Notes item from the Window menu, if you want to make any notes.

3.      Save your garden by selecting the  button from the Main Toolbar or select Save 
from the File menu.

To use the set of plants in the gardens as a new criteria in the Plant Filter:

1.      Open the Encyclopedia Window by clicking on the  button from the Main Toolbar or
select Encyclopedia from the Window menu.

2.      Open the Plant Filter by clicking on the Filter button.
3.      Use the Additional usage button for setting additional criteria for the selected plants.



Change size of an object mode.

In this mode, single objects or a group 
of objects are surrounded with a chain 
of handles for changing external size

. The cursor will take the form of
 when pointing at these handles. 

For some objects there may also be a 
chain of handles for changing internal 

size  within them. The cursor will 
take the form of  when pointing at 
these handlers.



Rotating object mode.

In this mode objects or groups of 
objects are surrounded with a chain of 
handles for rotating . The cursor 

will take the form of  when 
pointing at these. A Handle for 

changing the centre of rotation  
allows you to change the centre of 
rotation of an object or group of an 
object. The cursor will take the form of

 when pointing at these.



Change curvature of an object mode.

In this mode objects are surrounded 
with a chain of
handles for changing the curvature

 of the selected object.

The cursor will take the form of  
when pointing at these handles.



Handles

A Handle is a small item on the selected object (normally taking the form of a 
square of some description). These allow you to transform that particular object.
Described below are all the kinds of handles that you will find within the program:
Change size of an object mode:

Handles for changing external size. Allows you to 
change the external size of an object.
Handles for changing internal size. Allows you to 
change the internal size of an object.

Rotating object mode:
Handle for changing the centre of rotation of an 
object. Allows you to move the centre of rotation of 
an object.
Handles for rotating. Allows you to change the 
orientation of an object.

Change curvature of an object mode:
Handle for changing curvature. Allows you to change 
the curvature and length of an object.



Placing lines/strip shapes.

This mode allows you to place objects as strips or lines in the garden plan. With such 
objects you are able to change the curvature, resize and revolve.

NOTE: With some objects you are not able to change the sizes.

Examples

See also: Placing an object in the garden plan



Placing at ellipse shape.

This mode allows you to place objects in ellipses on the garden plan. With such objects you 
can both resize and rotate them.

Examples

See also: Placing an object in the garden plan



Placing a rectangle shape.

This mode allows you to place objects in rectangles on the garden plan. These objects can 
be altered in size and can be rotated.

Examples

See also: Placing an object in the garden plan



Examples for line/strip:

 Surface object.

 Fencing object.

 Plant object.



Examples for ellipse:

 Surface object.

 Fencing object.

 Plant object.



Examples for rectangle:

 Surface object.

 Fencing object.

 Plant object.



 Plan Window

This is the main document viewing window.
It contains an editable plan of your garden, that can be viewed in day or night settings, as 
well as at different times of the year!
Above this window you will find the Plan toolbar which displays the actual size of your 
garden design. Below the Plan Toolbar and along the left hand side of the window are Rulers.
Use the cursor keys or mouse to move the cursor to the window area. The cursor shape will 
be changed according to the current operation.

See also: Placing an object in a garden plan for description of the placing procedure, 
Selection of an object or group of objects.

Described below are the various object types that you can place in your garden plan:

 Surface object

 Structure object

 Fencing object

 Camera object

 Decor object

 Lighting object

 Vehicle object

 Plant object

 OLE objects





Surface object.

Surface object. This is an area inside the garden plan in the form 
of a strip, ellipse or rectangle. There are many kinds of surfaces 
available to you including water, gravel, lawn, stones, sand etc. with
various borders and interior patterns. 
Overlapping surface objects with the same border and internal 
patterns automatically merge. This allows the generation of 
complex figures from simple ones (e.g. lawns, roads, beaches and 
etc.).



Structure object.

Structure object. This object represents an industrial or private 
construction (for example buildings, houses, garages, greenhouses, 
sheds) as well as sports areas. They are all of a rectangular form, 
but can be combined with similar objects to make more complex 
figures. The default dimensions of sports areas correspond to 
common standards, but if you wish you can always rotate any 
structure and\or change it length, width or height.



Fencing object.

Fencing object. This object represents enclosures of various types 
like wooden, concrete or stone fences. You can place fencing in the 
form of a line, an ellipse or a rectangle and can even adjust the 
distance between neighbouring elements of the fence.



Decor object.

Decor object. Choose from over 40 adornments to add to your 
garden plan (e.g. table, chairs, barbecue). You can even change the 
colour of some of them!



Lighting object.

Lighting object. This is an electrical lighting object whose effect 
you can see when viewing the garden plan in a night time setting. 
You can change their power wattage and height, to vary the range 
of light that they spread.



Vehicle object.

Vehicle object. Choose from over 20 different vehicle types, (e.g. 
cars, bicycles, boats) which you could have stored in your garden. 
For most of them you can even choose the appropriate colour!



Plant object.

Plant object. This is one of the many plants described in the 
Encyclopedia Window. You can view the garden plants appearance 
in different months by changing the current month in the Month 
Combo Box shown on the Plan Toolbar. Before placing a plant object
you can set the type of planting: single, outline or area and choose 
its form for instance a line, stripe, ellipse or rectangle. Furthermore, 
the density of planting can be adjusted.
For each plant you can view its care calendar in the Plant Care 
Dialog and look at the list of possible plant diseases in the Plant 
Diseases Dialog. 
You can view a list of plant types that you have placed in your 
garden (and a rough count of their numbers) in the Care Window. In
this window you can also check what tasks each plant needs 
performing on it throughout the year.



OLE objects.

OLE objects. These are embedded objects that are imported from 
other applications (for example a spreadsheet package). You can 
place and size an OLE object in any part of your garden plan. This 
object can be displayed as an icon. See Convert Dialog Box. For 
most OLE objects (not bitmaps) you can also select a standard edit 
window or transparent background (see No Window Background 
command). An OLE object is imported from a running application via
the Windows Clipboard (Copy/Paste procedure) or from a file 
(through the Insert New Object command).



Camera object.

Camera object. This is camera inside the garden plan. You can 
move or rotate it to view the garden from any angle. All changes are
displayed in the 3D View Window.



 3D Window

This is the 3D viewing window.
It contains a 3D plan of your garden, that can be viewed in day or night settings, as well as 
at different times of the year!
Above this window you will find the 3D toolbar.
Use the cursor keys or mouse to navigate within the window area.

See also: Plan Window.



 Landscape Window

This is the landscape viewing window.
It contains landscape plan of your garden.
Above this window you will find the Landscape toolbar.
Use the cursor keys or mouse to edit the landscape within the window area.

See also: Plan Window.



 Care Window

This window contains an alphabetically sorted list of plant species that you have placed in 
your garden. The left-most column contains the total number of plants of each species along
with a plant type icon (tree, flower, climber, water plant, etc.). A scrollable group of columns 
on the right-hand side of the window contains up to four plant care icons for each month: 
showing what tasks should be performed on each plant in each corresponding month.

Month scroller
On the top row of the window you will see left and right arrow buttons. Use these to scroll 
the month columns displayed in the window.

Plant total column
Contains the total number of plants of each given species in your garden plan.

Plant name column
Contains the full name of the plant. The type of name displayed (Latin or Common) is 
determined by the current selection within the Encyclopedia Window. 
Double click on the name to view this plants information in the Encyclopedia Window. 

NOTE: If you have turned on a filter in that window, you will see this plants details, but it will 
not appear in the list of plants in that window.

Month columns
Contains care icons for each month. 
Click on an icon to view brief care information in a Gardening Dialog. 

NOTE: You can print a care calendar for the selected month by using the File|Print menu 
entry or clicking on the     printer button on the Main Toolbar. Use File|Print Preview to 
see what the output will look like. To obtain a printout of the last months in the year (e.g. 
December), you will need to resize your display window so that only one column month is 
displayed and then scroll to the required month and then print.

See also: Print Care Window





 Notes Window

This window represents a simple text editor for keeping notes about your garden.
The text is saved within the Garden Designer document file (a file with extension    GRD). 
Note text can be printed on your printer, by using the File|Print menu item, or by clicking on 
the     printer button on the Main Toolbar.
Text can be copied and pasted to and from other applications, using the standard windows 
clipboard commands. 

NOTE: You will need to select the text that you wish to copy from the Notes Window before 
copying it onto the clipboard.



 Encyclopedia Window

This window contains information on more than 1500 species of plants.
Within the encyclopedia it is possible to retrieve information about any plant, to choose 
plants based on certain criteria, to look at potential diseases that each plant might suffer 
from, and how to take care of a given plant.

For the currently selected plant:
To view a list of possible plant diseases use the Diseases command.
To view the care calendar use the Care Calendar command.
To add/edit your own notes on that plant use the Notebook command.
To place the currently selected plant in your garden plan use the Place button .

You can print an image of the Encyclopedia Window using the Print command.
You can use the Plant Filter to select a smaller group of plants based upon certain criteria 
that you have set.

The various information and control fields of this window are:

List of plants
Contains all the plants that were filtered by the Plant Filter. The list is ordered by the 
Common or Latin plant name. You can switch between Latin and Common names by using
the Latin / Common command or Latin / Common button. Selecting an item in the list, 
results in all the information fields being updated with that plants details. Having selected
an item in the list you may scroll through the list using the up and down arrow keys and 
page buttons.

Search edit field
This appears above the list of plants. This edit field allows you to enter the first letters of 
a plant name to be selected within the list of plants.

Name of the current plant
This displays the Latin or Common name of the currently selected plant within the plant 
list

The picture of the plant
Certainly the picture is only a pale reflection of the bright colours found in nature, but it 
offers a general representation of the plant.

Buttons describing plant
Appearing beneath the plant picture, these buttons give you a choice of viewing the 
additional pictures. These show important material for the currently selected plant, if 
available.

See also: Description buttons.

View from above
This is a representation of how the plant will look when viewed from above. This is how 
the plant will be appear when placed within your garden plan.

Plant silhouette
This image presents a plant profile or tree skeleton, along with sizing (in metres) of the 
typical height and spread of that plant.



Season colour diagram
The outer circle shows which months the plant blooms in and the colour of its flowers. For 
fruits, you will also find the period in which they ripen is shown, together with the colours 
of their fruits at this time.
The inner circle indicates when the plant has foliage (including autumn leaves) and what 
colour its leaves are.

Plant usage buttons
Contains all possible usage of a given plant within your garden and home. Click one of the
buttons to view brief usage descriptions in the Plant Usage Dialog.

Place button
Click on this button to enter the Plant Dialog and place the currently selected plant within 
your garden.

Filter button
Click this button to invoke a Plant Filter and select a subset of plants based upon various 
criteria.

Latin / Common button
Press this button to switch between Common and Latin plant names in the plant list.

Scale of height of plant and size of its underground or underwater part
This slider indicates the plant height and size of its underground or underwater part (in 
feet or metres). The Underground part is only shown for vegetables. Underwater part is 
shown only for water plants. For trees its maximum height reached in Europe is indicated,
for others the height during the blossoming period is shown. The plant reaches the 
mentioned height at maturity and under favourable conditions!

Plant width scale
This slider indicates the average width of the plant in feet or metres. The plant reaches 
the mentioned width at maturity and under favourable conditions. For bushes and flowers
it depends on how they are pruned.

Plant Type
This information field contains a plant type icon showing the type of the currently 
selected plant.

 Watering
This information field contains a watering icon showing how much water the currently 
selected plant prefers.

Lighting
This information field contains a light exposure icon to show how much light the currently 
selected plant prefers.

Temperature
This information field contains a temperature icon to show the level of warmth that the 
currently selected plant prefers.

The type of ground
This information field contains a soil icon showing the preferred soil type for the currently 
selected plant. If the soil in your garden is different from the one shown, you may dress 
your soil with various treatments to enhance conditions for these plants.

Hardiness zone range
This text field shows the range of Rheders hardiness zones in which the currently selected
plant will grow. Zones are numbered from 1 to 10. Zone 1 corresponds to a sub-Arctic 
climate, zone 10 to a subtropical climate.



Plant Lifetime
This text field indicates the average lifetime of a plant in years. For trees its maximum 
lifetime under favourable conditions. For other plants it is the best growing time between 
division or other such renewal.



 Plant Filter 

Use this window to filter out unwanted plants and reduce the Encyclopedias plant list by 
selecting various criteria.
All the icons and scales in this window represent plant selection criteria. Each group of icons 
and each slider corresponds to single criteria (e.g. the plant watering icon group, plant 
lifetime slider).
Ticked icons and slider thumb positions indicate the possible properties of the selected 
plants. If some of icons disappear, it is as a result of no such plants being selectable with the
current criteria, (e.g. selecting minimal water will cause the climber button to disappear: this
is because there are no climbers that accept minimal watering!)
If you select more than one icon within a single group, then all plants with any of the ticked 
properties will be selected, (e.g. selecting maximum light and medium light will end up 
excluding all plants that dont flourish under minimal light conditions).
Another example: if you click on yellow and red in the colour selection list, then all plants 
with yellow or red flowers will be selected.
If icons/sliders in different groups are ticked/moved, then plants that satisfy all the selected 
criteria will be selected. For example, if you set the thumbs of the plant height slider in 
positions 1 and 3 meters, and click on AUG in the circle diagram, and then click on the 
Fragrant plant button, then only plants 1-3 metres tall that blossom in August and smell 
pleasantly will be selected!
To change the criteria on sliders, move their thumbs to the preferred position. To change the 
criteria of button groups, click on an icon or press the space bar when the focus frame is 
around it. Selected icons are indicated by a red tick mark; selected buttons are shown as a 
pushed down button. To deselect a button or icon, click on it again.
Use the following buttons to perform the actions described below::

OK - close the window saving the current filtering.
CANCEL - close the window and reject filtering changes made.
RESET - cancel the selection criteria and reset filtering to show ALL plants.

The following window fields control plant selection criteria:
Type group

Select plant types by selecting one or more plant type icons.

Watering group
Select plant watering conditions by checking one or more watering icons.

Lighting group
Select plant light exposure conditions by checking one or more lighting icons.

Temperature check group
Select plant temperature conditions by checking one or more temperature icons.

Soil check group
Select plant soil conditions by checking one or more soil icons.

Leaves / Flowers and Fruits / Autumn Leaves circle diagram
The various sectors of this diagram correspond to months.
The outer circle in Leaves / Flowers mode (red) indicates the TOTAL blossoming months 
and in Fruits / Autumn Leaves mode (pink) shows the TOTAL months when fruits ripen of 
all the currently selected plants.
The inner circle in Leaves / Flowers mode (green) indicates the TOTAL months of foliage 
and in Fruits / Autumn Leaves mode (yellow) shows the TOTAL months while foliage stays 
with autumn colour of all the currently selected plants.
With ALL plants selected by the filter, you will see that the database contains no plants 
that bloom in January!



You can select the preferred foliage, blossoming or fruit months by clicking on the month 
abbreviations around the edge of the circle. Selected months are indicated by a white rim.
For selecting blossoming months enter Flowers mode, for selecting months of foliage 
switch to Leaves mode or to Autumn Leaves mode, for fruit months enter in Fruits mode. 
Use the Leaves / Flowers and Fruits / Autumn Leaves switch button to switch between 
these modes.

Leaves / Flowers and Fruits / Autumn Leaves colour selection list
This list contains 6 leaf colours in Leaves mode, 10 flower colours in Flowers mode, 8 fruit 
colours in Fruits mode and 2 autumn leaf colours in Autumn Leaves mode. Use the Leaves
/ Flowers and Fruits / Autumn Leaves switch button to switch between these modes. To 
select one or more flower or leaf colours click on the required colour with the left mouse 
button. If some colours are disabled it means that there are no such plants which have 
this colour, and match the other selection criteria.

Leaves / Flowers and Fruits / Autumn Leaves switch button
Click this button to switch between Leaves, Flowers, Fruits or Autumn Leaves modes.
This allows the colour and circle diagrams to be used to select criteria for leaves, flowers, 
fruits or autumn leaves. The currently displayed picture on the button indicates which 
mode the button is in:

Flowers mode

Leaves mode

Autumn Leaves mode

Fruits mode

Plant height slider
By moving the thumbs of this slider up and down you can set the selection of plants to 
have a height within the indicated range. If these have not been moved, then selecting 
other criteria will move them automatically to show the height range within that selection.

Plant lifetime slider
Use this to choose the average lifetime of plants in the current selection. If it has not been
changed, then selecting other criteria will move it automatically to show the age range of 
plants within that selection.

Usage buttons
This group contains buttons for all possible plant uses within your garden and home. Click
on one or more buttons to select plants by usage. If you select more than one button, 
then the plant selection will have plants that meet at least one of the selected criteria.
If some buttons are disabled, it means that the current set of selected plants does not 
contain any plants that have such a usage.

Additional usage button
Use this button to choose your plants from the set that you have already used when 
creating your garden.
To change the basic set of plants here, double click on the button with the left hand 
mouse button. The actual button name will vary through text in the notes of the chosen 
garden.



See Creating and use new set of plants.

Hardiness zone slider
Using this slider you can select the range of Rheders hardiness zones that you wish your 
plants to be capable of living within. Zones are numbered from 1 to 10. Zone 1 
corresponds to sub-Arctic climate, zone 10 to subtropical climate.

Hardiness zone map
This map shows the selected hardiness zones in a light green colour. 
A light brown colour indicates an area in which no plants within the current selection are 
capable of growing.

Cursor shape  indicates that the Hardiness zone map can be zoomed in on by 
clicking on it with the left mouse button.

Cursor shape  shows that the Hardiness zone map can be zoomed out on by clicking on 
it with the left mouse button.

Quantity of selected plants
This field shows total number of plants satisfying your selection criteria. When you first 
enter this dialog box it indicates the number of plants filtered by previous use of the Plant
Filter.

Reset button
Click this button to reset any filtering and to view all plants in the database.



Plant type icons

Deciduous trees.

Coniferous trees.

Bushes (deciduous and 
coniferous).
Flowers.

Bulbs.

Climbers.

Herbs and grasses.

Ferns.

Vegetable.



Watering icons

Constant watering. For plants living in wet places 
or growing by the edge of lakes, rivers and streams. 
Such plants need moisture rich soils.
Occasional watering. For plants that need watering
only during dry periods, e.g. trees and lawns.
Watering not required. For plants that prefer arid 
conditions. They require good drainage and will not 
endure excess moisture.



Lighting icons

Full shade. For plants that require shade. Such 
plants grow badly in open places.
Half shade. For plants that grow in open sunlight, or 
with some shade.
Open place (Full sunlight). For light-loving plants 
that do not grow well in the shade.



Temperature icons

Warmth-loving plants. Plants that grow best in 
warm conditions.
Moderate temperature. Plants that can endure 
short, mild frosts.
Frost-resistant plants. Plants that can endure the 
hardest of frosts. Such plants dont require winter 
covering.



Soil icons

Sandy soil. For plants that require friable, but not 
rich soils.
Lime soil. For plants that love lime soil and a high 
pH value.
Peat soil. For plants that love friable and sour soils. 
Mulching soil with peat will improve its quality for 
such plants.
Clay soil. For plants that require dense and moisture 
retaining soils.
Stony soil. For plants that require good drainage.



Cursor Shapes.

Program is busy.

When pointing at an object.

When placing an object.

When pointing to or dragging the handle for centre of
rotation of an object.
When pointing to a handle for rotating an object,
When pointing to a handle for changing the curvature
of an object or indicates that the object may be 
moved on the plan.
When pointing to a handle for changing external size 
of an object.
When pointing to handle for changing internal size of 
an object.



Underground part of plant    



Underwater part of plant    



Place menu Commands

The Place menu offers the following commands:

Command Action
Surface Place surface area into plan
Structure Place structure object into plan
Fencing Place fencing object into plan
Decor Place decor object into plan
Lighting Place lighting into plan
Vehicle Place vehicle into plan
Camera Place camera into plan

Surface Command (Place menu)

Use this command to place a surface object in your garden plan.
This command displays the Surface Dialog.
For more information about surface objects see Surface Object.

Shortcuts
Plan Toolbar:

Keys: Shift+S



Structure Command (Place menu)

Use this command to place a structure in your garden plan.
This command displays the Structure Dialog.
For more information about surface objects see Structure Object.

Shortcuts
Plan Toolbar:

Keys: Shift+E



Fencing Command (Place menu)

Use this command to select and place a fencing object in your garden plan.
This command displays the Fencing Dialog.
For more information about surface objects see Fencing Object.

Shortcuts
Plan Toolbar:

Keys: Shift+F



Decor Command (Place menu)

Use this command to select and place a decorative element within your garden plan.
This command displays the Decor Dialog.
For more information about decor objects see Decor Object.

Shortcuts
Plan Toolbar:

Keys: Shift+D



Lighting Command    (Place menu)

Use this command to select and place a lighting object in your garden plan.
This command displays the Lighting Dialog.
For more information about lighting objects see Lighting Object.

Shortcuts
Plan Toolbar:

Keys: Shift+L



Vehicle Command (Place menu)

Use this command to select and place a vehicle in your garden plan.
This command displays the Vehicle Dialog.
For more information about vehicle objects see Vehicle Object.

Shortcuts
Plan Toolbar:

Keys: Shift+V



Camera Command (Place menu)

Use this command to select and place a camera in your garden plan.
This command displays the Camera Dialog.
For more information about vehicle objects see Camera Object.

Shortcuts
Plan Toolbar:



Plant menu Commands

The Plant menu offers the following commands:

Command Action
Care Display care information about the 

currently selected plant species
Notebook Write/edit notes on the currently 

selected plant species
Diseases Display a list of possible diseases for the

currently selected plant species
Latin / Common 
names

Switch between Latin and Common 
plant names (encyclopedia view)

Place Place the current plant species into your
garden plan

Filter Invoke the plant database filter 
(encyclopedia view)



Care Calendar Command (Plant menu)

Use this command to display care information for the currently selected plant species.
This command displays the Care Calendar Dialog.

Shortcuts
Main Toolbar:

Keys: F2



Diseases Command (Plant menu)

Use this command to view a list of possible diseases for the currently selected plant 
species.
This command displays the Plant Diseases Dialog.

Shortcuts
Main Toolbar:

Keys: F4



Notebook Command (Plant menu)

Use this command to write or edit notes on the currently selected plant species.
This command displays the Encyclopedia Notebook Dialog.

Shortcuts
Main Toolbar:

Keys: F3



Filter Command (Plant menu)

Use this command to bring up the plant database filter.
This command displays the Plant Database Filter.

Shortcuts
Keys: F5



Common / Latin names Command (Plant menu)

Use this command to switch between Common and Latin names of plants.

Shortcuts
Keys: F8



Plant place Command    (Plant menu)

Use this command to place the currently selected plant into your garden plan.
This command displays the Plant Dialog.
For more information about plant objects see Plant Object.

Shortcuts
Plan Toolbar:

Keys: F9



Zoom + Command

Use this command to zoom into the current garden plan view.

Shortcuts
Plan Toolbar:



Zoom - Command

Use this command to zoom out of the current garden plan view.

Shortcuts
Plan Toolbar:



Day Command

Use this command to display the garden as it would appear in the day time

Shortcuts
Plan Toolbar:



Night Command

Use this command to show the garden as it would appear at night time

Shortcuts
Plan Toolbar:



Print Command (File menu)

In this dialog you can set the number of pages, the zoom and printing area of the plan; and 
then go on to print it.
This command displays the Print Dialog.

Shortcuts
Main Toolbar:

Keys: CTRL+P



Plan Options Command (View menu)

Use this command to set the garden plan view options.
This command displays the Plan Options Dialog.

Shortcuts
Plan Toolbar:

Keys: F7



Month Combo Box

Use the Month Combo Box to select the month in which you would like to view your garden.
By choosing a month, it is possible to see how plants will appear at this time of year with 
their foliage and colour variations.
Choose All Colours to view all the plant colours independent from the month.



No background / Window background Command (pop-up menu)

Use this command to switch between the standard window background and a transparent 
background for OLE objects.

NOTE: Some objects ignore this command (for example PaintBrush objects).



Reset size Command (pop-up menu)

Use this command to reset the size of an OLE object to its original size in the source 
document.



Comments Command (pop-up menu)

Use this command to view and edit an object's note text in the Plan Notebook Dialog.



Properties Command (pop-up menu)

Use this command to view and change an objects properties in an object window.

Shortcuts
Mouse: double click on an object with the left mouse button.



Replace Command (pop-up menu)

Use this command to change the species of a currently selected plant object.
This command shows the Plant Change Dialog and Encyclopedia Window simultaneously.
To change the species of plant, select the appropriate plant in the Encyclopedia and click 
on the OK button in the Plant Change Dialog.
To cancel the replacement, click on the Cancel button in the Plant Change Dialog.



Care View Command (pop-up menu)

Use this command to view information about the selected plant in the Care Window.
This command shows the Care Window and highlights the currently selected plant object 
species.



Encyclopedia View Command (pop-up menu)

Use this command to view information about the selected plant object in the Encyclopedia 
Window.
This command shows the Encyclopedia Window and fills all the fields of this window with 
information about the selected plant species.



Care Calendar Dialog

In this dialog you can view monthly care information about the currently selected plant 
species. The plant care information is organised as a table, months listed in columns and 
rows for the various operations.
The icons show which gardening operation the currently selected plant needs in any given 
month. Clicking on an icon with the left mouse button displays the Gardening Dialog 
window with more information about this task.



Gardening Dialog

This dialog shows information about a selected garden care operation. The image on the 
left shows an overall view of the gardening operation, whilst the text on the right describes 
various steps and conditions for the operation.
If the Animate button is enabled, you can watch an animation of the image by clicking on 
that button. Click on the Stop button to stop the animation once it is running.



Encyclopedia / Plan Notebook Dialog

In this window you can view and edit notes on the currently selected plant species.
Any notes you make whilst in the Encyclopedia are stored in a database separate to the 
gardening files, and can thus be viewed in any garden that you might create / load in the 
program.
The notes made for objects within a garden are unique to that object and are saved within 
the garden database file.
Click on the Save button to save any changes made to text and close the dialog.
Click on the Close button to close the dialog without saving any text changes.



Plant Diseases Dialog

This window contains information on more than 200 types of diseases. 
Here it is possible to retrieve information about any disease and how to take care of a given
plant. Use the Diseases Filter to reduce the list of diseases.

Disease
This field contains the name of the currently selected plant disease within the Search edit 
field.

List of diseases
Contains all diseases that were filtered by the Diseases Filter. The list is alphabetically 
ordered. Selecting an item in the list, by clicking on it, results in all the information fields 
being updated with that diseases details. Having selected an item in the list you may 
scroll through the list using the up and down arrow keys and page buttons.

Search edit field
Appearing above the list of diseases, this edit field allows you to enter the first letters of a
disease name to be selected within the list of diseases.

The picture of the disease
This field contains colour Illustrations of the disease.

Buttons describing disease
Appearing beneath the disease picture, these buttons give you a choice of viewing any 
additional pictures and video clips that may be available.

See also: Description buttons.

Descriptions
This is a description of external signs of diseases.

Prophylactics
This gives you information on how to care for infected plants, ways of preventing the 
selected illness as well as the actual treatments.

Encyclopedia
Show Encyclopedia with selected disease criteria. In this case the List of plants that you 
get are those which can be subject to the chosen disease.

Diseases Filter
Click this button to invoke the Diseases Filter and select a subset of diseases based upon 
various criteria.

All
Reset to All diseases in list of diseases.

Current
Set to all possible diseases for current plant.

All on plan



Set to all possible diseases for all plants on the plan.



Plant Usage Dialog

The Plant Usage dialog shows selected plant usage information.
The picture on the left illustrates the usage described in the text on the right side of the 
dialog.
This window pops up when clicking on a usage button in the Encyclopedia Window or 
double clicking on a usage button within the Plant Filter.



Plant Dialog

In the Plant dialog you can set placement options for a Plant object.
It is possible to choose single or group planting, and to set the density and configuration of 
the planting.

Seeding buttons
Click on one of these buttons to select one of the following seeding types:

Single planting. Only one plant will be 
planted. Spacing and Shape will then 
be disabled.
Outline planting. Plants will be placed 
in a line, around an ellipse or around a 
rectangle in the form of a chain. This 
seeding type is most suited to flower 
beds and borders.
Area planting. Plants will fill all the 
space    within an object.

NOTE: You cannot use these buttons for lawn plants.

Spacing slider
Use this slider to set the density of planting (the distance between neighbouring plants) in
the range 0 to 3 metres.

Scaling slider
Use this slider to vary the scale of plants from 50% to 150%. The default value of scale is 
100%.

Shape buttons
Click on one of the buttons to select one of following shapes of plant object:

 Line/strip

 Ellipse

 Rectangle

To place an object with the selected properties click on the OK button.

See also: Placing an object in the garden plan





Surface Dialog

In the Surface dialog you can set the properties of a Surface object.
Here you can setup garden paths with borders, lawns and ponds and then include them in 
your garden plan.

List of surfaces
This list contains more than 40 surface types with several different interiors and borders.

Width slider
This slider sets the width of your object. You can vary it in the range 0.5 - 20 metres.

Border slider
This slider sets the width of a border which you wish to add to your object in range of 0 to 
2 metres. Setting this to zero removes the border.

Shape buttons
Upon pressing one of these buttons you can select one of the following surface shapes:

 Line/strip

 Ellipse

 Rectangle

Place Over button
Click on this button to place the surface on top of other surface objects. Usually the 
overlapping surfaces are placed in the order they appear in the surface list (like objects 
being merged together), later items in the list on top of earlier items in the list. This 
button changes this order of surface overlapping. This doesnt allow you to place surface 
objects on top of other objects such as decor objects!!

To place an object with the selected properties click on the OK button.

See also: Placing an object in the garden plan





Structure Dialog

Within here you are able to choose a structure or sports area to be included on your garden
plan.
In the Structure dialog you can also set the properties of a Structure object.

Length, Width and Height sliders
Ranges of sliders are:

Length from 1 to 200 metres;
Width    from 1 to 200 metres;
Height from 0 to 15 metres (height used for information purposes only)

To place an object with the selected properties click on the OK button.

See also: Placing an object in the garden plan



Fencing Dialog

Within this dialog you can choose the type of fencing that you require, its shape and set the
spacing between neighbouring elements.
In the Fencing dialog you can also set the properties of a Fencing object.

Shape buttons
Select one of the buttons shown below to choose the shape of the fence object that you 
wish to place:

 Line/strip

 Ellipse

 Rectangle

Spacing slider
Set the distance between neighbouring fencing elements from 0 to 3 metres. A value of 
zero will give you a solid fencing outline.

To place an object with the selected properties click on the OK button.

See also: Placing an object in the garden plan



Lighting Dialog

In the Lighting dialog you can set the properties of a Lighting object, its power and height.
By viewing the garden in night mode you can then check the placement and setting of 
lighting by their lighting area.

Power buttons
Here you can choose the power of your light in watts.

Height slider
The height slider indicates the lighting height above the ground: you can vary this value 
from 0 to 5 metres. Changing the height changes the spread of light!

To place an object with the selected properties click on the OK button.

See also: Placing an object in the garden plan



Plan Options Dialog

In the Plan Options dialog you can set various viewing options for your Plan Window: day or
night time, view month, guide grid, display area and zoom factor. These are saved with 
your garden design.

Time slider
Use the Time Slider to set the time of day for viewing the plan (day or night). In Night 
mode you can view the lighting area of Lighting Objects.

Zoom Slider
Use the Zoom Slider to set the required zoom size. The slider indicates the dimension of 
garden area visible in the Plan Window.

Grid Slider
Using this slider you can set the size of the guide grid for your garden plan. Size 0 is off.

Months list
By choosing a month it is possible to see how plants will look at this time of the year and 
to view their corresponding colours.

 Show icons
Tick these icons to select what is/is not displayed within your garden plan. This is useful if 
you want to look at only certain aspects of your garden, e.g. the flowers.

trees (higher than 1 metre),

flowers (beneath 1 metere),
paths,
structures,
fencing,
single objects (vehicle, lighting or 
decor objects).

A red check mark indicates that a given set of objects is visible.

Animate drawing icon

 When this icon is ticked, you will see objects drawn in the Plan Window a layer at a time. 
Deselecting this gives faster drawing speeds.

Plan navigation window
The left pane shows a plan of the entire garden. The navigation frame indicates the plan 
area that will be visible in the Plan Window with the current zoom. Use the mouse or 
arrow keys to move this frame around within your garden plan; thus changing your view 
when you return to your Plan Window.





Garden Print Dialog

In the Garden Print dialog you can set the number of X and Y pages used to print out your 
garden plan, their relative position to your garden and the zoom factor for printed pages. 
Having done this you can then print straight away, or preview what the output from the 
program will appear like on your printer.

Printing area view
The left side of the dialog shows a miniature garden plan. The frames on it indicate the 
printing area divided into pages. Use the mouse or arrow keys to change the page 
locations relative to your garden plan.

Horizontal pages (X-direction)
This slider sets the number of pages along the horizontal direction. The range is from 1 to 
7 pages.

Vertical pages (Y-direction)
This slider sets the number of pages along the vertical direction. The range is from 1 to 7 
pages.

Page zoom
This slider sets the page zoom factor from 1 to 30.

Print preview button
Click on this button to get a Print Preview.

Print setup button
Select this button to bring up the Print Setup dialog.



Plant Change Dialog

The Plant change dialog allows you to change one plant species for another.
Select the new plant species in the Encyclopedia and then click the OK button in the Plant 
Change dialog.
To cancel the replacement operation, click on the Cancel button in the Plant Change dialog.

See also: the Replace command.



Zoomed Image Dialog

This dialog box contains an image of an object increased in size.

Image name
This is the name of the displayed object. 

Close
Click on the Close button to close the dialog. 



Decor / Vehicle Dialog

In this dialog box you can set the properties for a Decor or Vehicleobject.

Colour buttons
Use these buttons to choose the colour of the selected object.

To place an object with the selected properties click on the OK button.

See also: Placing an object in the garden plan



Object general view

This area gives a general view of an object.



View from above 

This area shows how your plant will appear in your garden plan.



OK button 

Press this button to accept changes made and close the window.



Cancel button 

Press this button to cancel changes made and close the window.



Object type list

This list box contains different object types.
To quickly search for an item by its first letter, enter in the corresponding letter into the list 
box.



Plan Background Dialog

Choose one of the plan background patterns or colours in the list.
The left side of the dialog shows a sample of the background selected.
Press OK button to accept the selection.



Month dialog

Choose the month in which you would like to view your garden plan from the list supplied. 
The selected month will be highlighted.
Press the OK button to accept the selection. The chosen month will appear in the Month 
Combo Box.



Diseases Filter
Use this window to filter out unwanted diseases to reduce the list of diseases by selecting 
various criteria.

Reset
Reset filtering to show ALL diseases.

Criterion list
This is a list of plant parts, which can be used as selection criteria.

Quantity of selected diseases
This field shows the total number of diseases satisfying your selected criteria. When you 
first enter this dialog box it indicates the number of plants filtered by a previous use of 
the Diseases Filter.





Description buttons

By selecting the buttons as shown below you are able to get additional pictorial 
information.

Button Description
    

Leaves
Blossom
Trunk
Roots
Branches without foliage
Cone
Edible fruit
Group of flowers
Branches with foliage
General view of plant
Landscape
Bush
Cereals
Inedible fruits
Bulb
Needles
Indoor plants
Dry plant
Insect
Rodents
Dry plant
Root-Crops
Stem
Cabbage-head
Vegetable
Vegetable
Sound
Berry
Lawn
Caterpillar





 House Wizard Step 1

Use this step to set up the dimensions of the building, the width and depth as well as the 
number of floors required.
To resize the structure, using the left mouse button drag the handles until the correct 
dimensions are displayed in the size boxes.
Select the relevant Radio button to select the number of floors required.
Click on the forward pointing arrow to move onto the next step of the Wizard.
Click on the backward pointing arrow to move back a step.
Click on OK to accept the buildings with the settings you have entered so far.
Click on Cancel to exit the Wizard. Any changes you have made will be lost.



 House Wizard Step 2

Use this step to set the base parameters to your building, i.e. the surface surrounding your 
building on the ground.
Choose the relevant dimensions and texture/colour for this.
Also set the floor texture/colour for inside the building. Only needed for open sided 
structures.



 House Wizard Step 3

Use this step to determine the height of each floor of your building. Select the floor you 
want to adjust from the drop down list, then move the slider to the height that you require.
In this step you also set up the parameters for the external wall texture/colour.
Select the wall that you want to adjust by clicking on the relevant button so a tick is 
displayed across the button. Then click on the texture button. Make your choice then click 
on OK to apply it to the wall. Do this for each wall of your building.
Also set up any roof overhang you may have on your building. Set it to Zero, if it is flush to 
the walls.



 House Wizard Step 4

Use this step to add the windows and doors required to your building. Select the wall, roof or
base you want to add them to, by clicking on the relevant button so a tick is displayed 
across it. Then make the choice of which windows/doors you want to add from the display 
above.
To position the object, select and drag from the display onto the wall then release the mouse
button. You are then free to resize/reposition the items. To reposition just click and drag to 
the correct location. To resize drag the relevant handle until the object reaches the desired 
size.    If you place the wrong object on your plan you can delete it by clicking and dragging 
the object back to the display above.
If the object is too big to fit on the area that you have selected, the cursor will change form 
to a circle with a line through it. Try moving your cursor around the surface of the wall as it 
may fit but only just. If it doesnt then you must go back and increase the size of the wall to 
position the window/door, then resize the object you have placed, then set the dimensions 
back to how they should be for the wall in question.



 House Wizard Step 5

Use this step to add plants to the walls of your structure.
Choose the plant you want to use from the encyclopedia list on the right hand side of the dialog.
Choose the wall you want to add a plant to by selecting the relevant button.
From the plant icon window, found in the middle at the top of the dialog, click and drag away from it. You 
will notice that a segment of the plant is now connected to the mouse pointer. Release it when you have it
at the correct location on the surface.
You can then reposition and resize the plant in the same way as with windows.



 House Wizard Step 6

This is the final step.
Use this step to adjust the roof of your structure to meet your requirements
Select the type and orientation, the height and slope of the roof.
You can then select the textures that you want to apply to the different parts of the roof.
Tip: For a flat roof, set the height to 0 (Zero).

Once you have made the final decisions, and you are happy with all the amendments that you have 
made, click on the OK button to transfer the structure on to your plan. You are then free to position it at 
the correct location. If after placing the structure you are not happy with the result you can choose to 
amend it by double clicking on it to bring up the properties. This will take you through the wizard again.
Clicking on the cancel button will bring you out of the wizard and all changes you have made to the 
structure will be lost. 



 Tower Wizard Step 1

Use this step to choose the shape of the tower that you want to create, the dimensions and
the colours/textures.
To set the dimensions, drag the sliders to the correct size.
To change the textures of the walls, you must first either select the wall you want to apply 
it to. This is done by selecting the arrow button in the wall parameters section until the wall
you want to alter is facing towards you in the preview of the tower, found in the top right 
hand corner of the dialog. Alternatively, if you want the same texture/colour applied to all 
walls, click on the All Walls button.
Once you have selected the wall by either of the methods above, click on the Texture 
button to choose the texture/colour that you require.
Click on the forward pointing arrow to move onto the next step of the Wizard.
Click on the backward pointing arrow to move back a step.
Click on OK to accept the tower with the settings you have entered so far.
Click on Cancel to exit the Wizard. Any changes you have made will be lost.



 Tower Wizard Step 2 or 
 House Wizard Step 2

Use this step to set the base parameters to your tower, i.e. the surface surrounding your 
tower on the ground.
Choose the relevant dimensions and texture/colour for this.
Also set the floor texture/colour for inside the building. Only needed for open sided towers.



 Tower Wizard Step 3

Use this step to add the windows and doors required to your tower. Select either to add 
them to a wall, roof or base. Click on the arrow button until the correct wall/roof segment is 
displayed. Then make the choice of which windows/doors you want to add from the display 
above.
To position the object, select and drag from the display onto the wall then release the mouse
button. You are then free to resize/reposition the items. To reposition just click and drag to 
the correct location. To resize drag the relevant handle until the object reaches the desired 
size.    If you place the wrong object on your plan you can delete it by clicking and dragging 
the object back to the display above.
If the object is too big to fit on the area that you have selected, the cursor will change form 
to a circle with a line through it. Try moving your cursor around the surface of the wall as it 
may fit but only just. If it doesnt then you must go back and increase the size of the wall to 
position the window/door, then resize the object you have placed, then set the dimensions 
back to how they should be for the wall in question.



 Tower Wizard Step 4

Use this step to add plants to the walls of your towers.
Choose the plant you want to use from the encyclopedia list on the right hand side of the dialog.
Choose the wall you want to add a plant to by clicking on the arrow button until the correct wall is 
displayed in the preview.
From the plant icon window, found in the middle at the top of the dialog, click and drag away from it. You 
will notice that a segment of the plant is now connected to the mouse pointer. Release it when you have it
at the correct location on the surface.
You can then reposition and resize the plant in the same way as with windows.



 Tower Wizard Step 5

This is the final step.
Use this step to adjust the roof of your tower to meet your requirements
Select the type and orientation, the height and slope of the roof.
You can then select the textures that you want to apply to the different parts of the roof.
Tip: For a flat roof, set the height to 0 (Zero).

Once you have made the final decisions, and you are happy with all the amendments that you have 
made, click on the OK button to transfer the tower on to your plan. You are then free to position it at the 
correct location. If after placing the tower you are not happy with the result you can choose to amend it by
double clicking on it to bring up the properties. This will take you through the wizard again.
Clicking on the cancel button will bring you out of the wizard and all changes you have made to the tower 
will be lost. 



Landscape Dialog Box

Use this dialog box to select the landscape properties of your garden.



Input Height Dialog Box

Use this dialog box to enter the height of the chosen object.



Contour Lines Properties Dialog Box

Use this dialog box to alter the properties of the contours. Choose whether you want to 
display just lines or use a graduated fill.



Hill Dialog Box

Use this dialog box to make a hill.



Plane Sloping Dialog Box

Use this dialog box to select sloping parameters such as Azimuth and Angle.



Area Properties Dialog Box

If you want to move a surface up or down in a selected area use the parameters Height and 
Bounds in this dialog box. Enter Azimuth and Angle to slope a selected area.



Point Properties Dialog Box

Use this dialog box to set up the parameters of the selected point such as X, Y coordinates 
and Height.



Textures Dialog Box

Use this dialog box to select the texture required.



Select Sky Dialog Box

Use this dialog box to choose the sky required.



Camera Dialog Box

Use this dialog box to choose the camera.



Splash Animation Dialog Box

During the process of loading, this dialog appears.



Splash Dialog Box

This dialog appears in process of loading and contains information about authors rights and 
company-distributor of this program.






